HP Smart Document Scan
Software Guide
About HP Smart Document Scan Software

Introduction

HP Smart Document Scan Software is designed to assist you through the process of document capture with a scanner. Document capturing involves scanning pages, image processing, capturing text using Optical Character Recognition (OCR) technology, saving the document, or sending it to another application or destination. The basic capture process is quite automatic and simple:

1. Select a scan profile to specify what you would like to scan.
2. Insert pages into the scanner.
4. As needed, insert more pages to be scanned.

When a scan is started, the Scan Progress window opens. A progress indicator and status messages show the status of scanning and processing. When complete, the document is saved to a file and can be sent to specified destinations via links.

Minimum System Requirements

To install and run HP Smart Document Scan Software, your Windows-compatible PC must be equipped with the following:

- An Intel® Pentium® III processor or equivalent
- Microsoft® Windows® XP 32-bit, Windows XP 64-bit, Windows Vista and Windows 7 (minimum 800 MHz CPU)
- Microsoft Internet Explorer® 5.01 or above
- 512 MB of memory (RAM), 1 GB recommended. For Vista systems minimum 1 GB RAM is required, 2 GB is recommended.
- 300 MB of free hard disk space for installation
- An SVGA monitor with 16-bit color (called Medium Color in XP) and a resolution of at least 1024 x 768 pixels
- CD-ROM drive for installation
- A Windows-compatible pointing device
- Web access needed for obtaining live updates for the program

Performance and speed will be enhanced if the computer's processor, memory, and available disk space exceed the minimum requirements.

Scanners supported in this 3.1 release:
5000 – HP Scanjet 5000
7000 – HP Scanjet 7000
7500 - HP Scanjet 7500
9000 – HP Scanjet 9000
N9120 - HP Scanjet N9120
Installing the Software

The HP Smart Document Scan Software will be installed by the primary scan software installation, as described in its own documentation. The following describes how it install it as a separate program for a single scanner.

Before program installation, make sure your device's driver is installed properly.

Steps to install the program without using the general install browser:

1. Insert the CD into your CD-ROM drive.
2. Browse to the SmartDocument folder.
3. Double-click on Autorun.exe.
4. Select installation language and click OK.
5. Click Next in the Welcome screen.
6. Accept the License Agreement and click Next.
7. Specify the destination directory, choose to turn automatic web updates ON or OFF and then click Next.
8. Choose the scanner model, then click Install.
9. A profile management window appears if valid profiles are detected on your computer. For version 3.1 these may come from a previous installation of version 3.1, 3.0 or 2x. Choose to use only the existing profiles, only the newer ones or a combination. In the latter case, choose how to resolve naming conflicts. Then click Install again.
10. Click Finish to complete the installation.

Do not use this method to install additional scanners; run the new scanner’s installation program. It detects that this scanning software is already installed and does not reinstall it. After the installation, the new scanner should appear in the program’s Main Window. If there are multiple scanners of the same model, they list separately. If the program was running during the installation, it must be restarted for the new scanner to appear. Profiles for the new scanner must be imported manually (see later).

Main Features

HP Smart Document Scan Software is designed to meet the requirements of powerful high-speed scanners. It offers a user-friendly interface for accessing robust document-capture functionality. In addition to being able to capture pages at the rated page-per-minute (ppm) scanner speed, the program includes the following:

- **Scan Profiles**: The ability to use scan profiles that contain all settings for scanner usage, image processing, Optical Character Recognition (OCR) and barcode recognition, file formats and naming mechanisms, and saving or sending to different destinations such as FTP, WebFolders or different applications.

- **Preview Pages**: Visually validate the quality of images at the time of scan, and to manually set a selection area and crop the page. This feature simplifies the process of scanning small items such as a photo on a document page.

- **Page Management**: A method to view, edit, delete, insert, reorder pages, or separate pages into multiple documents.

- **OCR**: Integrated support for OCR and Searchable PDF creation

- **Links**: The ability to send files to different destinations via local or global network connections; sending to multiple destinations is supported.

- **Repositories**: Support for Microsoft® SharePoint and other ODMA-compliant storage programs.
Help

The general content of the Help is accessible at any time either by selecting Help from the Help menu or by pressing the Help button or the F1 key. This Help documentation includes the following:

- Tips for using HP Smart Document Scan Software more efficiently
- A Glossary with short explanations of most important terms
- Contents, Index, and Search tabs to the left of the Help topic pane to be used for finding a Help topic
- A comprehensive index structure that helps you find information on a particular function: click the Index tab to the left of the Help topic pane to view it

While working within a window or dialog box, click its own Help button or press F1 to access the related Help topic.

This document does not cover typical usage of the Microsoft Windows environment. See your Windows documentation if you have questions about how to use dialog boxes, menu commands, scroll bars, drag-and-drop functionality, and so on.

The Profile Settings dialog box has a new Vista-like interface that uses the concept of info tabs. Each tab has two or more info tabs. See: About Profile Settings.

Uninstalling

Follow the steps below to uninstall HP Smart Document Scan Software:

1. Select "Add or Remove Programs" (XP) or "Programs and Features" tool (Vista and Windows 7) from the Control Panel.
2. Select HP Smart Document Scan Software from the list.
3. Click Remove to uninstall the program or Change to auto-repair it.
4. When uninstalling, whose whether to keep or remove current profiles.

To remove a scanner model from the list, please remove its driver, and also all the profiles associated with it.
Working with HP Smart Document Scan Software

Starting the Software

The program lists in the Start menu under All Programs > HP > HP Smart Document Scan 3, with access to the program, this User's Guide and two separator pages.

When HP Smart Document Scan Software is first launched, the Main window opens with the installed scanner selected and a set of predefined scan profiles designed for that scanner model in the Scan Profiles list. If more scanners are installed, they appear in the list. By clicking each scanner model in turn, it is possible to view all available profiles.

Select one of the predefined profiles or create new ones; put the documents into your scanner and press the **Scan** button to start working with HP Smart Document Scan Software.

Main Window

When the program is launched, the Main window opens.

The Scanner area at the top lets you make a scanner selection if more than one is installed. The profile list shows only profiles suitable for the currently selected scanner. The lower area may change, depending on the functionality of the selected scanner.
Predefined and user-created scan profiles are displayed in the Scan Profiles list. Icons display scanner or profile status:

- ✔ Scanner or profile is available.
- ✗ Scanner was removed, disconnected, switched off or not installed when the program was started.
- ✗ Profile contains invalid settings or its associated scanner is not available.

To remove the red cross please restore, connect, switch on or install the scanner and then restart the program.

To learn more information about a profile, click on the profile name to see its short description in the box below the profile list. Write the descriptions in the Main tab of the Profile Settings dialog box.

The Create new profile, Edit profile and Delete profile buttons are used for profile management as described in detail in related Help topics.

Under the Scan Profile area, available Scan Sources are listed. Note that different sources (such as Feeder – simplex (1-sided); Feeder – duplex (2-sided); Feeder – duplex (2-sided), book; Feeder – duplex (2-sided), tablet; and Flatbed) might be displayed here, depending on your scanner's capabilities. Your selection will be valid until you change profiles or exit the program, or change the settings in the current profile.

Profiles can be reordered within the list:

1. Select a profile from the Scan Profile list.
2. Click Move profile up or Move profile down to reposition the selected profile within the list.

When a profile is selected, click the Scan button or select Scan from the File menu to start scanning.

Select Exit from the File menu to close the Main window and quit the program.

**About Scanning**

The necessary settings for common document capturing tasks are programmed in scan profiles. To start scanning, select a scan profile and:

- Click the Scan button, or
- In the File menu, select Scan.

When scanning starts, the Scan Progress window opens where you can monitor the scanning process.

You can also scan without using the Scan Progress window. To do this, unmark the checkbox **Show thumbnails when scanning** in the Scan Software Interaction info tab in the Main tab of the Profile Settings dialog box.
About Scan Profiles

HP Smart Document Scan Software includes a set of predefined scan profiles. You can create new profiles, as well as modify or delete existing ones. Profiles can also be imported and exported so that administrators can create profiles for a workgroup. Users can transfer their profiles from one machine to another, and they can also share custom profiles with each other.

Predefined profiles can be restored at any time to original settings if deleted or modified. This command will restore the original pre-defined profiles for all installed scanners.

Profiles are specific to each scanner model. A newly created profile is always for use with the current scanner model. The profile can be created from its default values, or by modifying settings from a listed, available profile.

If you import profiles for a supported scanner that is not installed, the scanner model appears and the profiles can be viewed, but both the scanner and the profiles are shown with the ‘not available’ icon.

When you install an additional scanner, its pre-defined profiles are not automatically loaded. Please import them from the installation directory at:

c:\<Program Files>\HP Smart Document Scan Software 3\<language>\<scanner model>\profiles.xml

where:

c: represents the letter of the system partition of your computer's hard drive (where Windows is installed)

<language> represents the language used for the names of the profiles

<scanner model> represents the model of the scanner for which you want to import profiles

About Managing Pages

If Show thumbnails when scanning is selected in the Scan Software Interaction info tab of the Main tab in the Profile Settings dialog box, the Scan Progress window opens once scanning is started (see next page).

The thumbnail view in the top left of the dialog shows thumbnails of the scanned pages. As the scanning progresses, each new page appears at the place indicated by the ‘Insert new pages here’ indicator. Tools are on the right side of the thumbnail view. Buttons are enabled or disabled depending on whether or not they are relevant for the current selection. See the Help topic Working with Thumbnails on how to use the tools.
The yellow I-beam is a document separator. These can be generated automatically during scanning or placed manually. A progress indicator and status messages at the bottom right inform you about the status of the process.

After scanning

- Click the **Scan** button at the bottom-right of the window to add more pages to the existing set of scanned pages. Scanning more pages might be necessary if, for example, the ADF cannot hold all of the pages of the original document that is being scanned. Change the **Paper source** setting (above the Scan button) to change the scan source for any additional scans.

- Display individual pages in the Preview Pages window by selecting a page within the thumbnail window, then clicking **Adjust page**. This lets you modify the page and move to other pages in the document.

- Inspect the scanned pages in the thumbnail view. Consider how the scanned pages are going to be organized into documents, and reorganize them if necessary. You can reorder pages to modify their sequence, separate pages into multiple documents, reverse the order of all pages, and delete pages and document separators.

- Click the **Done** button when all pages have been scanned and adjusted as necessary, and you are ready to create your final documents.
About Profile Settings

Access the Profile Settings dialog box from the Main window by selecting a profile and clicking **Edit profile**. The Profile Settings dialog box has a newly designed Vista-like interface – four tabs now replace five previous ones.

These new tabs have info tabs on the left which display the main settings made within the tab, giving you a quick overview of current settings without needing to open each tab. Info tabs typically present the content that was previously located within an area of an old tab panel. This rearrangement also serves to accommodate new choices.

The dialog box has the usual buttons: **Save**, **Cancel** and **Help**. As you change settings in the different tabs these are immediately actioned – some settings have dependencies to others, both in the same info tab and in others. When all settings in all tabs are ready, you must click **Save** to confirm all your changes. If you do not, they are all lost.

New buttons provide greater processing flexibility:

**Preview:** Click this to see a quick display of the first document page, to evaluate the effect of settings made (for example cut-off content due to over-enthusiastic cropping). The preview provides information only - the image is not saved. The Preview window lets you preview another page from the document. On closing the preview, modify settings as desired, then click **Save** or **Scan**.

**Scan:** Click this to have the document processed with altered settings that you do not want saved into the profile. This lets you choose the profile closest to your needs, fine-tune it and have the document processed, without disturbing your set of profiles.

About General Profile Options

Specify general profile options in the Main tab of the Profile Settings dialog box. This has two info tabs:

**Profile Name and Description**

Enter a profile name and if desired a description that summarizes the profile's main settings and targets or its purpose. This text displays in the info tab area on the left under the profile name, and also in the Main window whenever the profile is selected.

Scan Software Interaction

- **Show thumbnails when scanning.** If you leave this checkbox unmarked the Scan Progress window will not be shown during scanning. Instead, progress is indicated by an icon in the system tray. Right-click this icon to restore the Scan Progress window or cancel scanning.

- **Show a summary window once the scanning completes** (with or without the Scan Progress window - see above). If you choose to have this summary, you can also set how long it is shown on the screen. The summary includes information such as: number of pages scanned, scanning resolution, number of documents created, output format and target.
About Layout Settings

In the Profile Settings dialog box click the Scan tab and choose the Page Size and Page Layout info tabs to modify the related parameters.

Page Size

Under Page Size you can specify the following settings:

- A standard or custom page size, or choose the size of the page in the scanner
- Size and location of the scan area
- The unit of measurement for the above controls

See the Help topic Setting Page Size and Scanning Area.
Under Page Layout you can specify the following settings:

- Page orientation and scanning type (simplex or duplex)
- Scan source
- Page loading - i.e. rotate and feed options

See the Help topic: Setting Orientation and Paper Source.

The Layout info tabs are also available if you click **Rescan Settings** in the Preview Pages window.
About Scan Parameters and Image Options

In the Main window, select a scan profile and click **Edit** to open the Profile Settings dialog box. Click to open the Scan panel to specify scanning and layout parameters under five info tabs: Image Options, Page Size, Page Layout, Hardware Options and Color Dropout.

In the Preview Pages window, click the **Rescan Settings** button to modify scan parameters for a rescan.

**Image Options**

This picture shows the info tab contents when **24-bit color** is selected. Other color mode choices have different settings.
Select the desired **Resolution** from the drop-down list.

Select the **Color Mode** from the drop-down list.

- **1-bit halftone** may be used to improve the quality of scanned images that include pictures. Halftone scanning provides smaller file size than grayscale and improved picture quality over black-and-white scanning.

- **Auto detect** color may be used when you want to save pages with color data differently from the way black-and-white pages are saved. When scanning a document that has both color and black-and-white or grayscale pages, using Auto detect color can reduce the file size. However, processing time will increase.

The further settings in this area depend on the Color Mode choice. Set the desired percentage values for Threshold (may be available for black-and-white and auto-detect scanning), and for Brightness, Contrast and Midtone (available for color, grayscale, auto-detect and halftone scanning). When using halftone, a dither pattern may also be selected.

**Tip**

When scanning, specify a resolution of 300 to 400 dpi if you intend to extract image text with the OCR process.

**Page Size and Layout**

Already described. Choose a standard or custom page size and, if desired, a limited scanning area. Set page orientation, single or double sided content and scanning source, including ADF choices.

**Hardware Options**

Enable or disable detection of more than one page being pulled into the scanner, make a speed vs. quality choice for scans and specify the color of the ADF background. See the Help topic: *Hardware Options*.

**Color Dropout**

A dropout color is used to make page elements of a certain color invisible. Its main use is in forms processing, to separate pre-printed form elements from data entered by respondents. See the Help topic: *Dropout Color Options*.
**About Processing Options**

In the Profile Settings dialog box, open the Image Processing tab to specify the image and document processing settings of a profile. It provides three info tabs: Adjust each Scanned Document, Clean up Black & White Pages (new options) and Adjust Scanned Document.

**Adjust each Scanned Page**

- **Adjust each Scanned Page**
  - Crop to content on page
  - Resize page
  - Apply digital stamp
  - Erase edges
  - Remove background color
  - Reduce moiré

- **Clean up Black & White Pages**
  - No selection

- **Adjust Scanned Document**
  - No selection
    - Apply background filter
      - Remove background color (make white)
      - Smooth background color (make consistent)
    - Reduce moiré
The following operations can be carried out automatically to each scanned page in the document:

- Straightening skewed pages
- Orienting pages right side up, based on analysis of its text content.
- Cropping pages (removing edges)
- Resizing pages
- Erasing edges
- Applying digital stamps
- Modifying the page background

Beyond these automatic processing options, further individual post-processing is possible for each page in the Preview Pages window.

For more detail on these processes and their settings, see the Help topic: Adjusting Pages.

**Clean up Black-and-White pages**

These new options are available if Black-and-White or Halftone scanning is set. They are also available if Auto-detect color is set and the valid choices include Black-and-White or Halftone. In this case the modifications are applied to the non-color pages.

- Select **Smooth text** (for improved readability) to fill in the edges of characters that have jagged edges when printed on a page.
- Select **Remove noise** (despeckle) to remove extraneous dot-like data from a scanned image. The slider has three positions: light, normal, or heavy. Click on one to adjust the size and density of the noise to be removed from the page. Choosing Heavy might result in real page content being removed.
- Select **Remove holes** (fill holes with white background) to fill paper punch holes with white. Selecting this option will only fill holes at the edges of the page.
- Select **Apply line filter** and one of the radio buttons to either remove lines or to repair lines by filling in any gaps in lines created by the scanning process.

These options not only improve page appearance but are likely to improve the quality of using Optical Character Recognition on the pages.

**Adjust Scanned Document**

The following document adjustment options are available:

- Merging pages
- Saving barcode information
- Separating pages into multiple documents
- Removing blank pages
- Deleting separator pages
Merging Pages

For duplex scanning only, you can select the option of merging pages. If you mark this checkbox, front and back sides of each duplex scan will be merged into a single image. Due to the increased size of the resulting image merged pages cannot exceed the size of 97 square inches.

Once you have chosen to merge pages, the resizing option will not be available. Merge Pages may be used in conjunction with Auto-Orient to rotate the pages before they are merged.

If the two pages to be merged have different color mode settings, the 'higher' setting will be applied to both pages. For example, when using Auto-detect color it would be possible to merge a color page with a black-and-white page. In this case the latter page would still look black-and-white, but it would in fact be turned into a color page.
Saving Barcode Information
You can choose to save barcode information by marking the appropriate checkbox. In such cases barcode information from all detected barcodes in the document being saved are collected in an XML file that is stored at the same location as the saved file, with the same file name.

Some barcodes may not scan properly in halftone mode or at low resolution. See the Help topic: About Barcodes.

Separating Documents
You can also specify a document separator to be used to automatically separate a stack of pages into separate documents. The document separator can be one of the following:

- A fixed number of pages for each document
- A blank page
- A barcode found on the page
- An HP Separator Page

Deleting separator pages from scanned documents
When you use separator pages (blank or barcode ones) you also have the option to remove them from the document after scanning is finished. To do this, mark the checkbox Delete blank separator pages or Delete barcode separator pages. HP Separator Pages are always deleted.

Handling blank pages
Blank pages are a special case in scanning tasks: they can either be used as separators or can be marked to be discarded. Accordingly, there are two separate Blank page settings buttons in this tab:

- one is provided for the separation group (Separate pages into multiple documents/After each blank page)
- the other is under the page deletion controls (Delete pages from the scanned document/Delete blank pages).

You can set blank page treatment for either of the above two functions separately, by clicking the relevant Blank page settings button.

Check the Delete blank pages checkbox to delete blank pages. This does not depend on whether or not blank pages are being used as document separators. When this checkbox is selected, you can access the Blank Page Settings dialog box to set a threshold for blankness. This does not appear when blank pages are used as separators because the settings can be accessed from that control.

Also note that thumbnails of blank pages continue to appear in the thumbnail view even if this option is selected but none of them is going to be saved.
About Output Settings and Destinations

In the Profile Settings dialog box, open the Destinations tab to specify the output and destination settings of a profile. This panel has two info tabs: Save As and Send To.

Save As

You can select:
- The document file type and its settings. A variety of file type options exist for various file types. If a file type has options, the Settings button will be enabled; click it to launch a dialog box showing the settings for the chosen file type. For text type files, the OCR Settings dialog box is displayed where
you can specify layout and graphics options. For JPEG and TIFF image file types, you can specify different image quality and compression settings. See the section: PDF Settings.

- OCR Language: here you can specify the language of the document for output formats that contain text. An incorrect language setting reduces OCR accuracy.
- File naming rules: The file name consists of any combination of up to seven elements, with or without a linking character. See the Help topic: Naming Files.

Send To

This info tab provides new functionality - the ability to save scanning results to multiple destinations from a single profile. Files can be routed to multiple folders, to your system e-mail program, a Fax machine, FTP sites, a printer, Nuance OmniPage or PaperPort, other applications on your system that are detected or specified as Named Destinations, WebFolders, ODMA-compliant repositories, including Microsoft SharePoint 2003/2007 and 2010. For detail see the Help topic: Multiple Destinations Settings.
PDF Settings

PDF settings are specified from the Save As info tab in the Destinations tab of the Profile Settings dialog box. Choose PDF as file type and click Settings. The PDF Settings dialog box has three panels.

Type & Quality

![PDF Settings Dialog Box]

PDF Compatibility
Choose from PDF versions 1.0 to 1.7; the default is 1.7. To see what is supported in each version, see the Help topic: PDF Version Support. Recent versions provide smaller file sizes and more features, but older versions are more universally accepted. PDF/A is available only with version 1.4, and Linearized PDF from 1.2.
PDF File Type

HP Smart Document Scan Software offers two basic PDF types: **Non-Searchable** and **Searchable**.

**Non-searchable PDFs** contain page images only.

**PDF Image Only**
A PDF Image file contains a bitmapped image of a document or graphic. This popular format is useful when file size and content searching is not a concern and you need an exact replica of a document to share with others. For example, you may want to scan documents to the PDF Image format so that you can easily distribute them to business colleagues on the network.

**Searchable PDF files** contain text. Use this type if you want to index, search or work with the text content of your file (while preserving the exact document appearance).

Two basic types of **Searchable PDFs** are offered:

**PDF Formatted Text and Graphics**
Also known as ‘Normal PDF’. This is a crisp, high quality PDF file with fully searchable content by storing text as characters, rather than image. Because text is stored as characters, a file in this format can be edited in programs such as Adobe Acrobat or Nuance PDF Professional Converter. This format is the best for on-screen viewing and posting to web sites. The file size is typically smaller than PDF Image over Text, and the file content is externally searchable by programs and systems, such as Windows XP and Vista, that support full-content searches.

Mark the checkbox **Include word images for words recognized with low confidence** to have reject and suspect characters replaced by image overlays, so these uncertain characters display as they were in the original document. The PDF file can be viewed, searched and edited.

**PDF Image over Text**
A PDF Image over Text file contains a bitmapped image of a document or graphic with textual content stored as hidden text. It is an export format most useful for archiving legal and other content-critical documents. The format maintains an identical appearance to the original document and enables other programs, such as Adobe Acrobat, to search the file. Although the file size is typically larger than PDF Formatted Text and Graphics, these features make it the most useful format for archiving important documents. PDF Image over Text files can be indexed and searched by programs and systems, such as Windows XP, that support full-content searches.

For both PDF types, you can choose to have PDF/A compliant output, if PDF version 1.4 is set. PDF/A is a Portable Document Format standard. Use this to make sure that your PDF displays exactly identically regardless of the computer environment and that it can withstand changes in future technology innovation. PDF/A compliant files do not rely on external sources: they contain all the information necessary for display (device-independent colorspace definition, all fonts embedded, metadata based on standards).
The PDF/A standard excludes:
- audio files
- video files
- javascripts
- executables, and
- encryption.

You can choose **Linearized PDF** for PDF version 1.2 and above unless PDF/A is set. This optimizes the PDF file for fast web viewing. A large non-linearized PDF delivered on a web page may take up to a minute to display. A linearized file displays the first page quickly while the remaining pages are still being processed.

**PDF Image Quality**

Adjust the file size-quality trade-off with the slider. Higher image quality uses less compression and results in bigger files. Unless file size is an issue, use Best. This setting is available for all versions and types of PDF files. When saving to grayscale or color, it has an effect, regardless of the PDF version. When saving to black-and-white or halftone, it has an effect only from version 1.4. When saving to image-only or image over text the compression is applied to whole pages. When saving to the type formatted text and graphics (also known as Normal PDF), the compression is applied to pictures only.

Use **MRC** compression for the smallest possible file when creating image-only or image-over-text PDF files. An MRC-compressed PDF has a foreground layer (typically with text and high-quality images), a background layer (most often containing low-resolution background images or patterns) and a mask that specifies how to assemble the document image from the two layers.

**Tip:**

You can also influence compression applied at scanning time in the Hardware Options info tab on the Scan panel of the Profile Settings dialog box. If saving to PDF is intended, a higher quality scan is recommended, leaving the option to save to PDF with higher or lower quality. If low quality is set in both places, the result is likely to be poor.

**Metadata**

See a screenshot of this info panel in the Help topic: *PDF Settings*.

Metadata displays when a user views the file properties. Choose whether to define the metadata in advance of scanning or to be prompted at saving time. You can enter basic data for all scans and modify or add information at saving time.

You can add the following categories of metadata to your PDF files:
- Title
- Author
- Subject
- Keywords.

Use commas or semi-colons to separate multiple keywords.

You can choose to add barcode values as keywords. This takes effect only from the next scan; it cannot be used to add values from an already scanned document. See the Help topic: *About Barcodes*. 


Security

Choose to predefine the security settings for future scans here, or request prompting at saving time. You can enter basic settings for all scans and choose whether or not to apply security and if so modify the requirements at saving time. Two types of password can be entered: the Open Password and the Permissions Password. You can specify both, neither or one but not the other. Passwords must be no longer than 32 characters. There is no lower limit. The permissions password must be different from the open password.

PDF Password Security
Mark the checkbox **Require a password to open the document** to create password-secured PDF files. This option is not available if you have selected PDF/A compliance in the Type & Quality panel (see above).

To apply a password, type it into the Password field, into the Confirm Password field, and set the encryption level (see below). You can later pass this password to all people entitled to open PDF files created with this profile.
PDF Document Permissions

Mark the checkbox **Restrict editing and printing of the document** to allow or prohibit certain actions in the PDF file. Enter a permissions password twice. You can prohibit all actions except viewing the PDF or allow almost everything except page extraction. View the drop-down lists and choose the options you need. The options may vary, depending on the PDF file version. This password is also needed to remove the protection, change its type or change passwords.

You can later pass this password only to people entitled to modify the permissions for the PDF file. If a permissions password is entered, the file can be opened without needing to provide an open password, even if one is set.

Confirm your password choices by clicking **OK**. Be sure to also click **Save** or **Scan** in the Profile Settings dialog box, otherwise your new passwords will not be applied. **Scan** applies the passwords to the current document only. **Save** writes them into the profile so they are applied to all documents processed with that profile.

**Choosing encryption level**

AES-128 and AES-256 provide stronger encryption, but the resultant PDF file is only compatible from PDF versions 1.6 and 1.7 respectively. RC4-128 is not as strong encryption as AES-128, but the resultant PDF file is compatible with PDF versions 1.4 and above. So, if compatibility with earlier versions of PDF is a higher concern than security, then RC4-128 is recommended. However, if security is a higher concern than compatibility, then AES-128 or AES-256 is recommended.
Administrative Installation

Administrators can also install the software using command-line commands. This is useful for uniformly distributing pre-set installation parameters, typically set through the user interface, to a number of users.

SETUP.EXE is to be launched from the subfolder called "HP SmartDocument Scan Software 3". Here is an example for silent installation (/s parameter):

```
Setup /s /L<LangID> /v"INSTALLDIR="<destinationpath>"
REBOOT=Suppress WEB_UPD=1 PROFILE="<scanner model>"
NEWPROFILES=1 /qb"
```

where the following parameters are accessible:

- the /s parameter specifies silent installation (no user interaction is required / possible during the process)
- the /L parameter defines the user interface language for the program

Possible values for <LangID> are:

- 1033 - English
- 1036 - French
- 1031 - German
- 1040 - Italian
- 1034 - Spanish
- 1042 - Korean
- 1046 – Portuguese (Brazilian)
- 2052 - Simplified Chinese
- 1028 - Traditional Chinese

Default value: 1033 (English)

Non-silent installation will prompt for a language choice.

- **INSTALLDIR** is the destination path for the installation
  
  Default: "<ProgramFiles>\HP Smart Document Scan Software"

  For example: C:\Program Files\HP Smart Document Scan Software, where C: denotes system disk partition.

- **REBOOT** specifies whether or not to restart the system after installation
  
  Possible values:
  
  Force - always reboots after silent or non-silent installation.
  Suppress - if reboot is needed, the user is prompted to reboot or automatically reboots after silent installation.
  ReallySuppress - no reboot at all.

  Default value: Suppress

- **WEB_UPD** defines the availability of automatic and manual web updates
  
  Possible values:
  
  0 - Automatic web updates are turned OFF and cannot be accessed by the user from the application. Manual updating functionality is not accessible from the Help menu.
  
  1 - Automatic web updates are turned ON and can be turned off by the user from the application. Manual updating functionality is accessible from the Help menu.
  
  2 - Automatic web updates turned OFF and can be turned on by the user from the application. Manual updating functionality is accessible from the Help menu.
Default value: 2

If no valid value is specified, non-silent installation will prompt the user to turn automatic web updates ON or OFF. Switching automatic updates on/off is accessible for the user from the application. Manual updating functionality is also available for the user from the Help menu.

- **PROFILE** sets scanner profiles to be used in the program. Use this to select which device profiles the application should use on first startup.
  Scanners supported in this 3.1 release:
  5000 – HP Scanjet 5000
  7000 – HP Scanjet 7000
  7500 - HP Scanjet 7500
  9000 – HP Scanjet 9000
  N9120 - HP Scanjet N9120
  None - no profiles are selected (and the user is prompted to select a scanner)
  Default value: None
  If a different value is specified, no profiles will be installed. In such a case users either have to import or create profiles manually so that they can use the application.

- **NEWPROFILES** specifies installer behavior with new scan profiles. Use this during a re-install to define how existing and newly installed profiles are treated. Profiles from versions 3.1, 3.0 and 2.x can be reused.
  Possible values:
  0   - Keeps only the profiles that existed prior to installation
  1   - Keeps only the new profiles selected during installation.
  20 - New profiles are installed, old profiles are retained. If some profiles have conflicting names, old profiles are kept. Not valid if PROFILE="None" is specified.
  21 - New profiles are installed, old profiles are retained. If some profiles have conflicting names, new profiles overwrite old ones. Not valid if PROFILE="None" is specified.
  Default value: 1

During silent installation unspecified parameters will take their default values.

**Tip**
Specify 'qn' instead of 'qb' to install without progress indication.